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Introduction 
English Learner (EL) students are those students who are acquiring proficiency in the English Language. This document 
lists, describes, provides links to, and shows the availability of the various reporting and data tools offered to support EL 
students. Additionally, the last two sections of this document provide state of Michigan websites and contact 
information that can be used to get more information about the supports provided to EL students in Michigan. 

EL Outcome Reports & Data Tools Availability 
The table below lists the EL reports and data tools grouped by whether they are available publicly or only to secure, 
authorized users and whether they provide individual student or aggregate data (e.g., counts, average scores, etc.). The 
table also shows whether the report or data tool is available for districts, schools, and different sizes of EL programs.  

For descriptions and locations of each report and data tool, please see later sections of this document. 

Please note: All public reporting is limited to groups of students with 10 or more students to protect student privacy as 
required by federal law (Family Educational Rights and Privacy Act; FERPA). 

Access 
Level 

Data 
Level Tool 

Districts Schools 
10 or 

More ELs 1-9 ELs 30 or 
More ELs 

10-29
ELs 1-9 ELs

Public Aggregate 
EL Dashboard      

Parent Dashboard for 
School Transparency 

     

Public Accountability 
Index System 

   *  

Secure, 
Authorized 
Users Only 

Aggregate WIDA AMS Aggregate
Reports      

OEAA WIDA Assessment 
Aggregate Data Files      

Secure Accountability 
Index System 

   * *

Student WIDA AMS Student 
Reports      

OEAA WIDA Assessment 
Student Data File      

Accountability Student 
Data File for the EL 
Components 

     

Accountability Student 
Data File for the Content 
Area Components 

     

*Values are displayed but not included in calculations. This is to ensure the stability of results used in high stakes
accountability.
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EL Outcome Reports & Data Tools, for the General Public 
The table below lists, describes, and provides links to reports and data tools supporting EL students that are available to the general public. 

Please note: All public reporting is limited to groups of 10 or more students. This is done to protect the privacy of individual students as required by federal law 
(Family Educational Rights and Privacy Act; FERPA). 

Report / Data Tool Description Location Supports 

Public  
English Learner (EL) 
Dashboard 

Provides aggregate outcome data specific to EL students at 
both the district and school levels. 

For groups with less than 10 students, data are not displayed. 

www.MISchoolData.org 
> K-12th Grade
> English Learner Data
> English Learner Dashboard

mde-oeaa@michigan.gov 
877-560-8378, option 5

Public 
Parent Dashboard for 
School Transparency 

Provides aggregate data for schools in multiple areas, and 
places that data in context of the state average and similar 
schools. One of those areas is English Learner (EL) Progress, 
which measures the percent of EL students demonstrating 
either English language proficiency or adequate growth to 
become English language proficient. 

For groups with less than 10 students, data are not displayed. 

www.MISchoolData.org 
> Parent Dashboard

mde-accountability@michigan.gov 
or 877-560-8378, option 3 

Public  
Michigan School Index 
System 

Provides aggregate outcome data in six areas for the school 
overall and for each student group in the school. One of those 
areas is English Learner (EL) Progress, which measures the 
percent of EL students demonstrating either English language 
proficiency or adequate growth to become English language 
proficient. The Michigan School Index System is used to 
identify schools most in need of further support.  

For groups with 10-29 students, data are displayed but not 
included in calculations.  

For groups with less than 10 students, data are neither 
displayed nor included in calculations. 

www.MISchoolData.org 
> K-12th Grade
> School Index

mde-accountability@michigan.gov 
or 877-560-8378, option 3 

http://www.mischooldata.org/
mailto:mde-oeaa@michigan.gov
http://www.mischooldata.org/
mailto:mde-accountability@michigan.gov
http://www.mischooldata.org/
mailto:mde-accountability@michigan.gov
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EL Outcome Reports & Data Tools, Only for Secure, Authorized Users 
The table below lists, describes, and provides links to reports and data tools supporting EL students that are available only to secure, authorized users. 

Please note: All secure, authorized user, reports and data tools providing aggregate data are for school and district internal use only. Only public reports 
should be shared publicly. This is because secure, authorized user, reports may contain data for groups smaller than 10 students and sharing them 
publicly could violate student privacy rights protected by federal law (Family Educational Rights and Privacy Act; FERPA). 

Report / Data Tool Description Location Support 
Secure  
WIDA AMS  
Frequency Reports 

Provides aggregate results (average PL, 
average scale score, etc.) for state EL 
summative assessment (WIDA ACCESS or 
WIDA Alternate Access). 

Can be run for state, district, or school. 

www.wida-ams.us 
>All Applications
>Report Delivery
>Test Results

How to access reports: 
WIDA@datarecognitioncorp.com 
or 855-787-9615 

About report content: 
help@wida.us or 866-276-7735 

Secure  
OEAA WIDA 
Assessment 
Aggregate Data Files 

Provides aggregate results (average PL, 
average scale score, etc.) for state EL 
summative assessment (WIDA ACCESS or 
WIDA Alternate Access). 

Can be run for state, ISD, district, or 
school. 

www.mi.gov/oeaa-secure 
> Reports
> Student Test Scores
> Select Test Cycle

(e.g., Spring 2017 WIDA WIDA)
> Select Report Type "Aggregate Data File"
> Select ISD, District, School
> Click the [Search] button

mde-oeaa@michigan.gov 
or 877-560-8378, option 5 

Secure 
Accountability 
Index System 

Provides aggregate outcome data in six 
areas for the school overall and for each 
student group in the school. It is used to 
identify schools most in need of further 
support.  

For groups with less than 30 students, 
data are displayed but not included in 
calculations  

www.mi.gov/oeaa-secure 
> Accountability
> Accountability Downloads
> Select Year, ISD, District, School
> Click the [Download] button
> Open the .zip file
> Open file "Accountability Report"

mde-accountability@michigan.gov 
or 877-560-8378, option 3 

http://www.wida-ams.us/
mailto:WIDA@datarecognitioncorp.com
mailto:help@wida.us
http://www.mi.gov/oeaa-secure
mailto:mde-oeaa@michigan.gov
http://www.mi.gov/oeaa-secure
mailto:mde-accountability@michigan.gov
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Report / Data Tool Description Location Support 
Secure  
WIDA AMS  
Student Reports 

Provides student level reports for WIDA 
ACCESS and WIDA Alternate ACCESS in 
English and in a variety of other languages 

www.wida-ams.us 
>All Applications
>Report Delivery
>Test Results, or
>On-Demand Reports

How to access reports: 
WIDA@datarecognitioncorp.com 
or 855-787-9615 

About report content: 
help@wida.us or 866-276-7735 

Secure  
OEAA WIDA 
Assessment Student 
Data File 

Provides student-level data results from 
each EL student’s state EL summative 
assessment (WIDA ACCESS or WIDA 
Alternate Access). 

www.mi.gov/oeaa-secure 
> Reports
> Student Test Scores
> Select Test Cycle

(e.g., Spring 2017 WIDA WIDA)
> Select Report Type "Student Data File"
> Select ISD, District, School
> Click the [Search] button

mde-oeaa@michigan.gov 
or 877-560-8378, option 5 

Secure  
Accountability 
Student Data File for 
the EL Components  

Provides student-level enrollment and 
assessment records used to calculate the 
EL accountability components (EL Progress 
and EL Participation). 

www.mi.gov/oeaa-secure 
> Accountability
> Accountability Downloads
> Select Year, ISD, District, School
> Click the [Download] button
> Open the .zip file
> Open "EL Student Data File"

mde-accountability@michigan.gov 
or 877-560-8378, option 3 

Secure 
Accountability 
Student Data File for 
the Content Area 
Components  

Provides student-level enrollment and 
assessment records used to calculate the 
Content Area (CA) accountability 
components (CA Growth, CA Proficiency, 
and CA Participation). 

www.mi.gov/oeaa-secure 
> Accountability
> Accountability Downloads
> Select Year, ISD, District, School
> Click the [Download] button
> Open the .zip file
> Open "Summative Student Data File"

mde-accountability@michigan.gov 
or 877-560-8378, option 3 

http://www.wida-ams.us/
mailto:WIDA@datarecognitioncorp.com
mailto:help@wida.us
http://www.mi.gov/oeaa-secure
mailto:mde-oeaa@michigan.gov
http://www.mi.gov/oeaa-secure
mailto:mde-accountability@michigan.gov
http://www.mi.gov/oeaa-secure
mailto:mde-accountability@michigan.gov
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Additional EL Resources 
The table below lists, describes, and provides links to state of Michigan websites providing additional information and 
resources supporting EL students. 

Topic Resource Description Location 

Accountability Michigan School 
Accountability 
Website 

Provides information, resources, and data for 
Michigan’s school accountability systems. 

www.mi.gov/mde-
accountability 

Assessment English Learner (EL) 
Assessment Website 

Provides information and resources to guide 
schools and district through the proper 
administration of state EL assessments (EL 
Screener, WIDA Access, and WIDA Alternate 
Access). 

www.mi.gov/wida 

Michigan School 
Assessment Website 

Provides information and resources to guide 
schools and district through the proper 
administration of all state assessments. Also 
houses the archives of the “Spotlight on 
Assessment & Accountability”, a weekly 
newsletter providing important information 
and dates related to state assessments and 
accountability. 

www.mi.gov/oeaa 

Assessment & 
Accountability 

Michigan Assessment 
& Accountability 
Secure Site 

Provides a secure portal where schools and 
districts can manage the student records 
associated with all state assessments and 
accountability. Additionally, it allows schools 
and districts to securely download reports and 
datafiles containing individual student results 
from state assessments. 

www.mi.gov/oeaa-secure 

Data 
Collection 

Michigan Student 
Data System (MSDS) 
Information Website 

Provides all supporting documentation for the 
Michigan Student Data System (MSDS). MSDS 
is the system through which EL students’ 
entrance and exit from EL services are 
reported. 

www.mi.gov/cepi 
> CEPI Applications
> Michigan Student Data
System

Instruction & 
Funding 

English Learner (EL) 
Program Website 

Provides information and resources to help 
schools and districts best deliver EL services to 
their EL students. 

www.mi.gov/mde-titleiii 

Reports Michigan School 
Reports Website 

Provides data and reports for all Michigan 
public schools in multiple areas (student 
assessments, student demographics, staffing 
information, financial information, etc.). 

www.MISchoolData.org 

OR 

www.mi.gov/MISchoolData 

http://www.mi.gov/mde-accountability
http://www.mi.gov/mde-accountability
http://www.mi.gov/wida
http://www.mi.gov/oeaa
http://www.mi.gov/oeaa-secure
http://www.mi.gov/cepi
http://www.mi.gov/mde-titleiii
http://www.mischooldata.org/
http://www.mi.gov/MISchoolData


English Learner Outcome Reports & Data Tools Overview 

Updated 12/3/2018 Page 7 of 7 

Contact Information 
For those having further questions about EL students, please use the table below to find the appropriate contact 
information. 

Topic Email Phone 

EL Accountability mde-accountability@michigan.gov 877-560-8378, option 3

EL Assessment mde-oeaa@michigan.gov 877-560-8378, option 5

EL Data Collections cepi@michigan.gov 517-335-0505, option 3

EL Instruction & EL Funding mde-EL@michigan.gov 517-241-5392

mailto:mde-accountability@michigan.gov
mailto:mde-oeaa@michigan.gov
mailto:cepi@michigan.gov
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